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The development/evaluation tool is designed to be used for research and development in a laboratory environment.  This 
development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made 
commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European 
Commission's Guide for the EMC Directive 2004/108/EC (8th February 2010).  
This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU. 
This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential 
requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity 
provided in the module datasheet and the module product page available at www.microchip.com. 
For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and 
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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP8026 TQFP BLDC Motor Driver Evaluation Board. Items discussed in this chapter 
include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP8026 TQFP BLDC Motor Driver 
Evaluation Board as a development tool to emulate and debug firmware on a target 
board. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the MCP8026 
TQFP BLDC Motor Driver Evaluation Board.

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with this user’s guide and a description of the user’s guide.

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the MCP8026 TQFP BLDC Motor Driver Evaluation Board.

• Appendix B. “Bill of Materials” – Lists the parts used to build the MCP8026 
TQFP BLDC Motor Driver Evaluation Board.

• Appendix C. “Software” – Provides information about the application firmware 
and where the source code can be found.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2017 Microchip Technology Inc. DS50002648A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user's guide describes how to use the MCP8026 TQFP BLDC Motor Driver 
Evaluation Board. Other useful documents are listed below. The following Microchip 
documents are available and recommended as supplemental reference resources.

• MCP8025/6 – “3-Phase Brushless DC (BLDC) Motor Gate Driver with Power 
Module, Sleep Mode, and LIN Transceiver” (DS20005339) — This data sheet 
provides detailed information regarding the MCP8025/6 product family.

• dsPIC33EPXXXGP50X, dsPIC33EPXXXMC20X/50X and 
PIC24EPXXXGP/MC20X – “16-Bit Microcontrollers and Digital Signal 
Controllers with High-Speed PWM, Op Amps and Advanced Analog” 
(DS70000657) — This data sheet provides detailed information regarding the 
dsPIC33EP256MC504 product family.

• “dsPIC33E/PIC24E Family Reference Manual” (DS70573)

• “dsPIC33EPXXXGP50X, dsPIC33EPXXXMC20X/50X, and 
PIC24EPXXXGP/MC20X Family Silicon Errata and Data Sheet Clarification” 
(DS80000533G) — This data sheet contains anomalies and clarifications for the 
dsPIC33EPXXXMC504 processor.

• AN1078 – “Sensorless Field Oriented Control of a PMSM” (DS01078)

• AN1160 – “Sensorless BLDC Control with Back-EMF Filtering Using a 
Majority Function” (DS01160)

• AN992 – “Sensorless BLDC Motor Control Using dsPIC30F2010” (DS00992)

• AN1292 – “Sensorless Field Oriented Control (FOC) for a Permanent Magnet 
Synchronous Motor (PMSM) Using a PLL Estimator and Field Weakening 
(FW)” (DS01292)

• AN901 – “Using the dsPIC30F for Sensorless BLDC Control” (DS00901)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives
 2017 Microchip Technology Inc. DS50002648A-page 9

ow.com.

http://www.arrow.com


MCP8026 TQFP BLDC Motor Driver Evaluation Board User’s Guide

Downloaded fro
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive an e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB® C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 Debug 
Express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2 and 3 programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (July 2017)

• Initial Release of this Document.
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Chapter 1.  Product Overview
The MCP8026 TQFP BLDC Motor Driver Evaluation Board is used to demonstrate the 
drive capabilities of the MCP8026. The board uses the MCP8026 3-Phase Brushless 
DC (BLDC) motor gate driver and dsPIC33EP256MC504 processor to implement a 
6-step trapezoidal BLDC motor controller.

The MCP8026 TQFP BLDC Motor Driver Evaluation Board is used to evaluate 
Microchip’s MCP8026 in a BLDC motor application. As provided, the MCP8026 TQFP 
BLDC Motor Driver Evaluation Board is ready to operate a BLDC motor using one 
on-board push button to start and stop the motor plus one on-board potentiometer to 
set motor speed. The evaluation board can drive a BLDC motor with a supply voltage 
of up to 24V and a motor current up to 15 amps. The MCP8026 TQFP BLDC Motor 
Driver Evaluation Board provides a 6-step trapezoidal control algorithm along with a 
750 mW buck converter, 5V and 12V LDO, high-to-low level voltage translators, current 
sense operational amplifiers, and Hall-effect inputs. The evaluation board provides a 
status indication for the power supplies and the six on-board Pulse-Width Modulation 
(PWM) inputs.

This chapter covers the following topics:

• What Is the MCP8026 TQFP BLDC Motor Driver Evaluation Board?

• What Does the MCP8026 TQFP BLDC Motor Driver Evaluation Board Kit 
Include?

FIGURE 1-1: MCP8026 TQFP BLDC Motor Driver Evaluation Board Block 
Diagram.

6V to 24V
Power Supply

MCP8026 Evaluation Board

+ -

Phase A
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Phase B
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1.1 WHAT IS THE MCP8026 TQFP BLDC MOTOR DRIVER EVALUATION 
BOARD?

The MCP8026 TQFP BLDC Motor Driver Evaluation Board is a complete stand-alone 
motor controller for brushless DC motors (BLDC). The board is capable of driving a 
three-phase brushless DC motor rated at up to 15 amps and 24V. The input voltage 
range for the board is 6V to 24V. The on board MCP8026 generates 5V and 12V using 
internal voltage regulators. The MCP8026 also contains an internal buck regulator 
which generates the power for the attached dsPIC33EP256MC504 host 
microcontroller. 

An input terminal block is provided to apply the input voltage to the board. An output 
header and plated Printed Circuit Board (PCB) through-hole pads are also provided as 
a means to connect the external motor. Two programming headers are available for 
updating the firmware contained in the dsPIC33EP256MC504 using either a PICkit 3 
programmer/debugger or an MPLAB® ICD3 in-circuit debugger.

An input terminal block is also supplied on the board, to allow users to connect 5V/12V 
Hall sensors signals.

1.2 WHAT DOES THE MCP8026 TQFP BLDC MOTOR DRIVER EVALUATION 
BOARD KIT INCLUDE?

This MCP8026 TQFP BLDC Motor Driver Evaluation Board kit includes:

• The MCP8026 TQFP BLDC Motor Driver Evaluation Board, ADM00599

• Information Sheet
DS50002648A-page 12  2017 Microchip Technology Inc.
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Chapter 2.  Installation and Operation
2.1 INTRODUCTION

The MCP8026 TQFP BLDC Motor Driver Evaluation Board demonstrates Microchip’s 
3-Phase Brushless DC (BLDC) Motor Gate Driver with Power Module, MCP8026, used 
in a BLDC motor drive application. When used in conjunction with a microcontroller, the 
MCP8026 will provide the necessary drive signals to drive for a 3-Phase BLDC motor. 
The MCP8026 contains the high-side and low-side drivers for external N-channel 
MOSFETs. A dsPIC33EP256MC504 processor is used to supply the PWM inputs to the 
MCP8026 as well as handle the high-speed Analog-To-Digital Conversion (ADC) 
required for 50 kHz PWM operation.

The MCP8026 UART interface is used to configure the MCP8026 device and to send 
fault information to the dsPIC® Digital Signal Controller (DSC). The evaluation board 
firmware, available on the Microchip web site, uses a 6-step trapezoidal drive control 
algorithm to demonstrate the MCP8026 capabilities.

2.2 FEATURES

The MCP8026 TQFP BLDC Motor Driver Evaluation Board has the following features:

• Input Operating Voltage Range: +6.0V to +24V

• Maximum of 500 mA of gate drive current for external N-Channel MOSFETs

• Drives up to a 15A BLDC motor

• 750 mW Buck Regulator with resistor-programmable output voltage

• ON/OFF momentary contact switch

• Reset momentary contact switch

• Spare user-programmable momentary contact switch

• PWM signal LED indicators

• PICkit 3 and MPLAB ICD 3 debugger interfaces

• Speed control potentiometer

• Terminal block for 5V and 12V Hall-effect sensors

• Programmable external MOSFET overcurrent protection

• Programmable PWM dead-time protection

• Programmable PWM blanking time for current switching spikes

• Complete “C” source code (provided on the board web page)
 2017 Microchip Technology Inc. DS50002648A-page 13
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2.3 GETTING STARTED

The MCP8026 TQFP BLDC Motor Driver Evaluation Board is fully assembled and 
tested for driving a BLDC motor. This board requires the use of an external voltage 
source capable of supplying 6V to 24V at the rated motor current. A BLDC motor is also 
required to evaluate the motor driver. 

FIGURE 2-1: MCP8026 TQFP BLDC Motor Driver Evaluation Board PCB.

2.3.1 Connections

2.3.1.1 JUMPER SETTINGS

The MCP8026 TQFP BLDC Motor Driver Evaluation Board has several 
user-configurable jumpers. The jumpers are described in Table 2-1 below.

TABLE 2-1: MCP8026 TQFP BLDC MOTOR DRIVER EVALUATION BOARD 
JUMPERS

Jumper Default Position Description

JP1   (MONITOR1)
JP2   (MONITOR2)
JP3 (MONITOR3)

3-4 1-2 Connect phase current to MONITORn

3-4 Connect filtered phase to MONITORn

5-6 Connect Hall Sensor to MONITORn

JP4 1-2 1-2 Supplies 5V to the Hall Sensors

2-3 Supplies 12V to the Hall Sensors

JP15 1-2 1-2 Current Sense offset = JP6 selection

2-3 Current Sense offset = 0.0V

JP6 OFF ON Current Sense reference = 1.651V

OFF Current Sense reference = 0.992V
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2.3.1.1.1 The jumpers and their use are described in Table 2-2.

TABLE 2-2: JUMPER DESCRIPTION

Jumper Name Position Description

JP1
Monitor 1 Input 
Selection 
(A/D Channel AN0)

1-2 Connects Phase A Current to Monitor 1 net

3-4 Connects Filtered Phase A Voltage to 
MONITOR1 net

5-6 Connects Hall Sensor A to Monitor 1 net

JP2
Monitor 2 Input 
Selection 
(A/D Channel AN1)

1-2 Connects Phase B Current to Monitor 2 net

3-4 Connects Filtered Phase B Voltage to 
MONITOR2 net

5-6 Connects Hall Sensor B to Monitor 2 net

JP3
Monitor 3 Input 
Selection 
(A/D Channel AN2)

1-2 Connects Phase C Current to Monitor 3 net

3-4 Connects Filtered Phase C Voltage to 
MONITOR3 net

5-6 Connects Hall Sensor C to Monitor 3 net

JP4 —
1-2 Supplies 5V to the Hall Sensors

2-3 Supplies 12V to the Hall Sensors

JP5 —
1-2 Current Sense Offset Voltage = JP6 selection

3-4 Current Sense Offset Voltage = 0.0V

JP6 —
1-2 Current Sense Reference Voltage = 1.651V

3-4 Current Sense Reference Voltage = 0.992V
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The jumper settings for use with the sensorless trapezoidal drive firmware are as 
described in Table 2-3.

2.3.1.2 POWERING THE MCP8026 TQFP BLDC MOTOR DRIVER EVALUATION 
BOARD (REFERENCE Figure 2-2)

1. Apply the input voltage to the input power terminal block, J3. The input voltage 
source should be limited to +24V. For nominal operation the input voltage should 
be between +6.0V and +24V.

2. Connect the positive side of the input power source (+) to pin 2 of J3. Connect 
the negative or return side (-) of the input source to pin 1 of J3. Refer to 
Figure 2-2.

FIGURE 2-2: Connection and Operation Diagram.

2.3.1.3 CONNECTING A MOTOR TO THE MCP8026 TQFP BLDC MOTOR 
DRIVER EVALUATION BOARD

Connect each phase winding of a three-phase BLDC motor to the appropriate terminal 
of the motor terminal block, J4, terminals A,B,C.

TABLE 2-3: JUMPERS USED BY SENSORLESS TRAPEZOIDAL FIRMWARE

Jumper Position Description

JP1 (MONITOR1)
JP2 (MONITOR2)
JP3 (MONITOR3)

3-4 Connect filtered phase voltage to MONITORn

Motor
Connections

VDD

GND

Switches
Test
Points

Power

Speed
Adjust

D
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ng
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gr
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Connector

Command

MCP8026dsPIC33-DSC
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2.3.2 Operating a Motor

1. Turn the SPEED adjust potentiometer (R92) fully counter-clockwise to obtain the 
slowest speed setting. Now turn the speed adjust approximately ¼ turn 
clockwise to allow for 25% motor speed.

2. Turn on the power supply.

3. Press and release the RUN/STOP switch (SW2) to start the motor.

4. Turn the Speed Adjust potentiometer clockwise to increase motor speed, 
counter-clockwise to decrease motor speed. The Speed Adjust changes the 
PWM duty cycle of the PWM signals being sent to the MCP8026.

5. Press and release the RUN/STOP switch again to stop the motor.

2.3.3 Indicator LEDs

The   MCP8026 TQFP BLDC Motor Driver Evaluation Board has ten LEDs to indicate 
system status. Table 2-4 lists the LED indicators and their descriptions.

2.3.4 Test Points

There are several test points on the board to allow probing of voltages, currents and 
signals. An abridged listing is shown in Table 2-5.

TABLE 2-4: LED INDICATORS

PCB Location Name Description

D11 SPARE Spare LED on dsPIC DSC RA4 port

D12 +12V +12V LDO voltage operating

D13 +5V +5V LDO voltage operating

D14 +Buck +3.3V Buck output voltage operating

D15 PWM3H PWM Phase 3 high-side input to MCP8026

D16 PWM3L PWM Phase 3 low-side input to MCP8026

D17 PWM2H PWM Phase 2 high-side input to MCP8026

D18 PWM2L PWM Phase 2 low-side input to MCP8026

D19 PWM1H PWM Phase 1 high-side input to MCP8026

D20 PWM1L PWM Phase 1 low-side input to MCP8026

TABLE 2-5: TEST POINTS DESCRIPTION

Test Point Name Description

TP1 VDD Power supply (+)

TP2, 4, 8, 9, 10 PGND Power supply ground (–)

TP3 DE2 MCP8026 DE2 communications signal

TP5 PHA Motor Phase A connection

TP6 PHB Motor Phase B connection

TP7 PHC Motor Phase C connection

VBn VBn Driver Bootstrap Voltage For Phase n

POT POT Motor Speed Potentiometer Output

ILIMIT ILIMIT ILIMIT_OUT signal from MCP8026

HVIN1 HVIN1 Level Shifter 1 input

HVIN2 HVIN2 Level Shifter 2 input
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MON1 MON1 Monitor Signal 1: connects to A/D input AN0

MON2 MON2 Monitor Signal 2: connects to A/D input AN1

MON3 MON3 Monitor Signal 3: connects to A/D input AN2

LVOUT1 LVOUT1 Level Shifter 1 output

LVOUT2 LVOUT2 Level Shifter 2 output

OVP CLAMP OVP CLAMP Gate pin of supply overvoltage clamp

PHA_FIL PHA_FIL Filtered Phase A BEMF signal

PHB_FIL PHB_FIL Filtered Phase B BEMF signal

PHC_FIL PHC_FIL Filtered Phase C BEMF signal

PWM1H PWM1H PWM phase A high-side input to MCP8026

PWM1L PWM1L PWM phase A low-side input to MCP8026

PWM2H PWM2H PWM phase B high-side input to MCP8026

PWM2L PWM2L PWM phase B low-side input to MCP8026

PWM3H PWM3H PWM phase C high-side input to MCP8026

PWM3L PWM3L PWM phase C low-side input to MCP8026

Q1G Q1G Phase A high-side MOSFET gate

Q2G Q2G Phase B high-side MOSFET gate

Q3G Q3G Phase C high-side MOSFET gate

Q4G Q4G Phase C low-side MOSFET gate

Q5G Q5G Phase B low-side MOSFET gate

Q6G Q6G Phase A low-side MOSFET gate

RA2, 3, 9, 10 RA2, 3, 9, 10 dsPIC DSC spare I/O pins

RB3 RB3 dsPIC DSC spare I/O pin

RC3-9 RC3-9 dsPIC DSC spare I/O pins

V_BUCK V_BUCK Buck 3.3V output voltage

TABLE 2-5: TEST POINTS DESCRIPTION (CONTINUED)

Test Point Name Description
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2.3.5 Reprogramming the On-Board dsPIC33EP256MC504

The on-board dsPIC33EP256MC504 may be reprogrammed with the user’s desired 
firmware. The processor may be programmed by using an external power source and 
either a PICkit 3, MPLAB REAL ICE in-circuit emulator or MPLAB ICD3 programmer.

1. Connect the power source to the board as explained in Section 2.3.1.2.

2. Connect a PICkit 3 to the J1 header or connect an MPLAB ICD 3 or MPLAB 
REAL ICE in-circuit emulator to the J2 (RJ25) jack.

3. Start up the MPLABX Integrated Development Environment (IDE) and load the 
MCP8026 TQFP BLDC Motor Driver Evaluation Board firmware project. In 
MCP802X.H, replace the definition for driver type: #define DRIVER MCP8026.

 

4. Build the project.

5. Program the device.

6. Press the RESET switch on the board to reset the processor and allow the 
processor to execute the new firmware program.

2.3.6 Configuring the MCP8026

The MCP8026 has configuration registers that may be used to modify operating 
parameters of the device. The parameters are modified by sending commands to the 
MCP8026 using the DE2 communication bus. The DE2 communication bus is a 
half-duplex, 9600 baud, 8-bit, 1-stop bit, 1-start bit, no parity, serial communication link.   
The user may add code to the evaluation board firmware to communicate with the 
registers. The evaluation board software contains a subroutine which initializes the 
MCP8026 registers.

There are three configuration registers that may be written to. The registers are written 
to by sending a SET_CFG_X command byte followed by the desired register value byte. 
The configuration messages and their respective requests are listed in Table 2-6.

Note: Note that the following project options may need to be changed for the 
computer being used to build the firmware:

•  Add Library libdsp-elf.a located in XC16  ???\src\Libdsp\lib 
directory.

•  Add XC16-as ASM Include Directory in XC16 ???\src\Libdsp\asm.

•  Set Hardware tool to “ICD 3”, “REAL ICE”, or “PICkit3”.
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TABLE 2-6: CONFIGURATION MESSAGE COMMANDS

Command Byte Bit Value Description

SET_CFG_0 1 10000001 (81H) Set Configuration Register 0

2 7 0 Reserved

6 — (Always ‘0’ in SLEEP mode)

0 Enable disconnect of 30 kΩ Level Translator pull up when CE = 0 
(Default)

1 Disable disconnect of 30 kΩ Level Translator pull up when CE = 0

5 0 System enters Standby mode when CE = 0

1 System enters Sleep mode when CE = 0
30 kΩ Level Translator pull up disconnect always enabled

4 0 Unimplemented:  Read as '0'

3 0 Enable MOSFET Undervoltage Lockout (Default)

1 Disable MOSFET Undervoltage Lockout

2 0 Enable external MOSFET short circuit detection (Default)

1 Disable external MOSFET short circuit detection

1:0 00 Set external MOSFET overcurrent limit to 0.250V (Default)

01 Set external MOSFET overcurrent limit to 0.500V

10 Set external MOSFET overcurrent limit to 0.750V

11 Set external MOSFET overcurrent limit to 1.000V

GET_CFG_0 1 10000010 (82H) Get Configuration Register 0

SET_CFG_1 1 10000011 (83H) Set Configuration Register 1
DAC motor current limit reference voltage

2 7:0 00H – FFH Select DAC Current Reference value
(4.503V - 0.991V)/ 255 = 13.77 mV/bit
00H = 0.991 volts
40H = 1.872 volts (40H x 0.1377 mV/bit + 0.991V) (Default)
FFH = 4.503 volts (FFH x 0.1377 mV/bit + 0.991V)

GET_CFG_1 1 10000100 (84H) Get Configuration Register 1
Get DAC motor current limit reference voltage

SET_CFG_2 1 10000111 (87H) Set Configuration Register 2

2 7:5 00H Reserved

4:2 — Driver Dead Time (For PWMH /PWML inputs) 

000 2000 ns (Default)

001 1750 ns

010 1500 ns

011 1250 ns

100 1000 ns

101 750 ns

110 500 ns

111 250 ns

1:0 — Driver blanking time (ignore switching current spikes)

00 4 µs (Default)

01 2 µs

10 1 µs

11 500 ns

GET_CFG_2 1 10001000 (88H) Get Configuration Register 2
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2.3.7 MCP8026 Configuration Message Responses

Table 2-7 describes the messages sent to host in response to a host command 
message.

TABLE 2-7: CONFIGURATION MESSAGE RESPONSES

MESSAGE BYTE BIT VALUE DESCRIPTION

SET_CFG_0 1 7:0 00000001 (01H) Set Configuration Register 0 Not Acknowledged (Response)

01000001 (41H) Set Configuration Register 0 Acknowledged (Response)

2 7 0 Reserved

6 — (Ignored in SLEEP mode)

0 Enable disconnect of 30 kΩ Level Translator pull up when CE = 0 
(Default)

1 Disable disconnect of 30 kΩ Level Translator pull up when CE = 0

5 0 System enters Standby mode when CE = 0

1 System enters Sleep mode when CE = 0, 30 kΩ Level Translator 
Pull Up disconnect always enabled

4 0 Unimplemented: Read as '0'

3 0
1

Undervoltage Lockout enabled (Default)
Undervoltage Lockout disabled

2 0 External MOSFET overcurrent detection enabled (Default)

1 External MOSFET overcurrent detection disabled

1:0 00 0.250V external MOSFET overcurrent limit (Default)

01 0.500V external MOSFET overcurrent limit

10 0.750V external MOSFET overcurrent limit

11 1.000V external MOSFET overcurrent limit

GET_CFG_0 1 7:0 00000010 (02H) Get Configuration Register 0 Response Not Acknowledged 
(Response)

01000010 (42H) Get Configuration Register 0 Response Acknowledged (Response)

2 7 0 Reserved

6 — (Ignored in SLEEP mode)

0 Enable disconnect of 30 kΩ Level Translator pull up when CE = 0 
(Default)

1 Disable disconnect of 30 kΩ Level Translator pull up when CE = 0

5 0 System enters Standby mode when CE = 0

1 System enters Sleep mode when CE = 0, 30 kΩ Level Translator 
Pull Up disconnect always enabled

4 0 Unimplemented: Read as '0'

3 0 Undervoltage Lockout enabled

1 Undervoltage Lockout disabled

2 0 External MOSFET overcurrent detection enabled

1 External MOSFET overcurrent detection disabled

1:0 00 0.250V external MOSFET overcurrent limit

01 0.500V external MOSFET overcurrent limit

10 0.750V external MOSFET overcurrent limit

11 1.000V external MOSFET overcurrent limit
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SET_CFG_1 1 00000011 (03H) Set DAC Motor Current Limit Reference Voltage Not Acknowledged 
(Response)

01000011 (43H) Set DAC Motor Current Limit Reference Voltage Acknowledged 
(Response)

2 7:0 00H – FFH Current DAC Current Reference value 13.77 mV/bit + 0.991V

GET_CFG_1 1 00000100 (04H) Get DAC Motor Current Limit Reference Voltage Not Acknowledged 
(Response)

01000100 (44H) Get DAC Motor Current Limit Reference Voltage Acknowledged 
(Response)

2 7:0 00H – FFH Current DAC Current Reference value 13.77 mV/bit + 0.991V

SET_CFG_2 1 00000111 (07H) Set Configuration Register 2 Not Acknowledged (Response)

01000111 (47H) Set Configuration Register 2 Acknowledged (Response)

2 7:5 00H Reserved

4:2 — Driver Dead Time (For PWMH /PWML inputs)

000 2000 ns (Default)

001 1750 ns

010 1500 ns

011 1250 ns

100 1000 ns

101 750 ns

110 500 ns

111 250 ns

1:0 — Driver Blanking Time (ignore switching current spikes)

00 4 µs (Default)

01 2 µs

10 1 µs

11 500 ns

GET_CFG_2 1 00001000 (08H) Get Configuration Register 2 Response Not Acknowledged 
(Response)

01001000 (48H) Get Configuration Register 2 Response Acknowledged (Response)

2 7:5 00H Reserved

4:2 — Driver Dead Time (For PWMH /PWML inputs)

000 2000 ns (Default)

001 1750 ns

010 1500 ns

011 1250 ns

100 1000 ns

101 750 ns

110 500 ns

111 250 ns

1:0 — Driver Blanking Time (ignore switching current spikes)

00 4 µs (Default)

01 2 µs

10 1 µs

11 500 ns

TABLE 2-7: CONFIGURATION MESSAGE RESPONSES (CONTINUED)

MESSAGE BYTE BIT VALUE DESCRIPTION
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2.3.8 MCP8026 Status Messages

The host may also solicit MCP8026 status information by issuing a STATUS_0 or 
STATUS_1 command. The MCP8026 may send an unsolicited STATUS_0 or 
STATUS_1 command to the host in the event of a fault or warning. The status 
messages are listed in Table 2-8.

TABLE 2-8: STATUS MESSAGES

Command Byte Bit Value Description

STATUS_0 1 7:0 00000101 (05H) Status Register 0 Response Not Acknowledged (Response)

01000101 (45H) Status Register 0 Response Acknowledged (Response)

10000101 (85H) Status Register 0 Command To Host (Unsolicited)

2 7:0 00000000 Normal operation

00000001 Temperature warning (TJ > 72% TSD_MIN = +115°C) (Default)

00000010 Overtemperature (TJ > +160°C)

00000100 Input undervoltage (VDD < 5.5V)

00001000 Unimplemented:  Read as '0'

00010000 Input overvoltage (VDD > 32V)

00100000 Buck regulator overcurrent

01000000 Buck regulator output undervoltage warning

10000000 Buck regulator output undervoltage (< 80%,brown-out error)

STATUS_1 1 7:0 00000110 (06H) STATUS Register 1 Response Not Acknowledged (Response)

01000110 (46H) STATUS Register 1 Response Acknowledged (Response)

10000110 (86H) STATUS Register 1 Command To Host (Unsolicited)

2 7:0 00000000 Normal operation

00000001 Reserved

00000010 Reserved

00000100 External MOSFET Undervoltage Lockout (UVLO)

00001000 External MOSFET Overcurrent Detection

00010000 Brown-out Reset – Config Lost (start-up default = 1)

00100000 5V LDO Undervoltage Lockout (UVLO) 

01000000 Reserved

10000000 Reserved
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2.3.9 MCP8026 Register Definitions

The MCP8026 registers contain the bits operated on by the messaging system. The 
registers are only accessible via the various messages. The registers are listed on the 
following pages.

REGISTER 2-1: CFG0: CONFIGURATION REGISTER 0
U-0 R/W-0 R/W-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0

— PU30K SLEEP — EXTUVLO EXTSC EXTOC1 EXTOC0

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

bit 7 Unimplemented: Read as ‘0’

bit 6 PU30K: 30 kΩ level translator pull up
1 = Disable disconnect of 30 kΩ pull up when CE = 0
0 = Enable disconnect of 30 kΩ pull up when CE = 0

bit 5 SLEEP: Sleep mode bit
Bit may only be changed while in Standby mode
1 = System enters Sleep Mode when CE = 0. Disconnect of 30 kΩ Level Translator pull up always 
enabled.
0 = System enters Standby Mode when CE = 0

bit 4 Unimplemented: Read as ‘0’

bit 3 Unimplemented: Read as '0'

bit 2 EXTSC: External MOSFET short circuit detection
1 = Disable
0 = Enable

bit 1-0 EXTOC<1:0>: External MOSFET overcurrent limit value
00 = Overcurrent limit set to 0.250V
01 = Overcurrent limit set to 0.500V
10 = Overcurrent limit set to 0.750V
11 = Overcurrent limit set to 1.000V

REGISTER 2-2: CFG1: CONFIGURATION REGISTER 1
R/W-0 R/W-1 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

DACREF7 DACREF6 DACREF5 DACREF4 DACREF3 DACREF2 DACREF1 DACREF0

bit 7                                                                                                                                                                              bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

bit 7-0 DACREF<7:0>: DAC current reference value
(4.503V - 0.991V)/255 = 13.77 mV/bit
00H = 0.991V
40H = 1.872V (40H × 0.1377 mV/bit + 0.991V)
FFH = 4.503V (FFH × 0.1377 mV/bit + 0.991V)
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REGISTER 2-3: CFG2: CONFIGURATION REGISTER 2
U-0 U-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

– – – DRVDT2 DRVDT1 DRVDT0 DRVBL1 DRVBL0

bit 7                                                                                                                                                         bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

bit 7-5 Unimplemented: Read as ‘0’

bit 4-2 DRVDT<2:0>: Driver Dead Time selection bits
000 = 2000 ns
001 = 1750 ns
010 = 1500 ns
011 = 1250 ns
100 = 1000 ns
101 = 750 ns
110 = 500 ns
111 = 250 ns

bit 1-0 DRVBL<1:0>: Driver Blanking Time selection bits
00 = 4000 ns
01 = 2000 ns
10 = 1000 ns
11 = 500 ns
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REGISTER 2-4: STAT0: STATUS REGISTER 0
R-0 R-0 R-0 R-0 U-0 R-0 R-0 R-0

BUVLOF BUVLOW BIOCPW OVLOF — UVLOF OTPF OTPW

bit 7                                                                                                                                                         bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

bit 7 BUVLOF: Buck Undervoltage Lockout fault
1 = Buck output voltage is below 80% of expected value
0 = Buck output voltage is above 80% of expected value

bit 6 BUVLOW: Buck Undervoltage Lockout warning
1 = Buck output voltage is below 90% of expected value
0 = Buck output voltage is above 90% of expected value

bit 5 BIOCPW: Buck input overcurrent protection warning
1 = Buck input current is above 2A peak
0 = Buck input current is below 2A peak

bit 4 OVLOF: Input Overvoltage Lockout fault
1 = VDD Input voltage > 32V
0 = VDD Input voltage < 32V

bit 3 Unimplemented: Read as ' 0'

bit 2 UVLOF: Input Undervoltage fault
1 = VDD Input voltage < 5.5V
0 = VDD Input voltage > 5.5V

bit 1 OTPF: Overtemperature protection fault
1 = Device junction temperature is > 160°C
0 = Device junction temperature is < 160°C

bit 0 OTPW: Overtemperature protection warning
1 = Device junction temperature is > 115°C
0 = Device junction temperature is < 115°C
DS50002648A-page 26  2017 Microchip Technology Inc.

m Arrow.com.

http://www.arrow.com


Installation and Operation

Downloaded from Arr
REGISTER 2-5: STAT1: STATUS REGISTER 1
U-0 U-0 R-0 R-1 R-0 R-0 U-0 U-0

– – UVLOF5V BORW XOCPF XUVLOF – –

bit 7                                                                                                                                                         bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

bit 7-6 Unimplemented: Read as ‘0’

bit 5 UVLOF5V: 5V LDO Undervoltage Lockout
1 = 5V LDO output voltage < 4.0V
0 = 5V LDO output voltage > 4.0V

bit 4 BORW: Brown-out Reset Warning, Configuration Lost
1 = Device internal reset has occurred since last configuration message
0 = No internal device reset has occurred since last configuration message

bit 3 XOCPF: External MOSFET overcurrent protection fault(Note 1)

1 = External MOSFET VDS > EXTOC value in CFG0 Register
0 = External MOSFET VDS < EXTOC value in CFG0 Register 

bit 2 XUVLOF: External MOSFET Gate Drive undervoltage fault(Note 2)

1 = HSx output voltage < 8V
0 = HSx output voltage > 8V

bit 1-0 Unimplemented: Read as ‘0’

Note 1: Only valid when CFG0<EXTSC> = 1.

2: Only valid when EXTUVLO = 1 in CGF0 register
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Appendix A. Schematic and Layouts
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP8026 TQFP 
BLDC Motor Driver Evaluation Board:

• Board – Schematic

• Board – Top Silk

• Board – Top Copper

• Board – Bottom Copper

• Board – MID1 Copper

• Board – MID2 Copper
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Appendix B. Bill of Materials
TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

7 C1, C4, C5, 
C16, C24, 
C25, C49

CAP CER 10uF 16V 10% X7R SMD 
1206

TDK Corporation C3216X7R1C106K

1 C2 CAP CER 1800pF 50V 10% X7R SMD 
0805

AVX Corporation 08055C182KAT2A

9 C3, C11, 
C19, C20, 
C52, C53, 
C54, C55, 
C56

CAP CER 1uF 10V 10% X7R SMD 0603 Taiyo Yuden Co., Ltd. LMK107B7105KA-T

7 C6, C8, C12, 
C18, C21, 
C50, C57

CAP CER 0.1uF 10V 10% X7R SMD 
0603

KEMET C0603C104K8RACTU

2 C7, C10 CAP ALU 470uF 50V 20% 0.027R RAD 
P5D12.5H20

United Chemi-Con EKZE500ELL471MK20S

6 C9, C31, 
C33, C37, 
C38, C39

CAP CER 0.1uF 50V 10% X7R SMD 
0603

Murata Electronics® GRM188R71H104KA93D

6 C13, C14, 
C15, C27, 
C29, C48

CAP CER 1uF 50V 10% X7R SMD 1210 Taiyo Yuden Co., Ltd. UMK325B7105KH-T

6 C17, C22, 
C23, C30, 
C34, C35

CAP CER 0.1uF 100V 10% X7R SMD 
0805

TDK Corporation C2012X7R2A104K

2 C26, C51 CAP CER 0.1uF 25V 10% X7R SMD 
0603

Murata Electronics GRM188R71E104KA01D

3 C28, C32, 
C59

CAP CER 10uF 50V 20% X7R SMD 
1210

TDK Corporation C3225X7R1H106M250AC

4 C36, C41, 
C47, C58

CAP CER 330pF 50V 5% NP0 SMD 
0603

Cal-Chip 
Electronics Inc.

GMC10CG331J50NTLF

6 C40, C42, 
C43, C44, 
C45, C46

CAP CER 100pF 50V 10% X7R SMD 
0603

Vishay 
Intertechnology

VJ0603Y101KXACW1BC

1 D1 DIO TVS SMAJ5.0A-E3/61 5V 400W 
DO-214AC_SMA

Vishay 
Intertechnology

SMAJ5.0A

4 D2, D3, D4, 
D5

DIO SCTKY SS24-TP 550mV 2A 40V 
SMD DO-214AC_SMA

Micro Commercial
Components

SS24-TP

3 D6, D8, D10 TVS DIODE 33VWM 53.3VC SOD123FL ON Semiconductor® SMF33AT1G

1 D7 DIO TVS SMAJ24A 24V 400W 
DO-214AC_SMA

Littelfuse® SMAJ24A

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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1 D9 DIO TVS PTVS10VS1UR 10V 400W 
SMD SOD123

NXP Semiconductors PTVS10VS1UR,115

1 D11 DIO LED RED 1.95V 20mA 220mcd 
Clear SMD 0805

Kingbright 
Electronic Co., Ltd.

APT2012SURCK

9 D12, D13, 
D14, D15, 
D16, D17, 
D18, D19, 
D20

DIO LED GREEN 2.1V 30mA Clear SMD 
0805

Kingbright 
Electronic Co., Ltd.

APT2012CGCK

1 J1 CON HDR-2.54 Male 1x6 Tin 5.84MH 
TH VERT

Sullins 
Connector Solutions

PEC06SAAN

1 J2 CON MODULAR RJ25 TH R/A TE Connectivity, Ltd. 5555165-1

1 J3 CON TERMINAL 5mm 18A Female 1x2 
TH R/A

Phoenix Contact 
GmbH & Co.

1935161

1 J4 CON TERMINAL 5mm 1x3 Female 
12-28AWG 16A TH R/A

On-Shore 
Technology, Inc.

OSTVI030152

1 J5 CON TERMINAL 2.54mm 1x5 Female 
20-30AWG 6A TH R/A

Phoenix Contact 
GmbH & Co.

1725685

3 JP1, JP2, 
JP3

CON HDR-2.54 Male 2x3 Tin 5.84MH 
TH VERT

FCI 67996-406HLF

2 JP4, JP5 CON HDR-2.54 Male 1x3 Tin 5.84MH 
TH VERT

Samtec, Inc. TSW-103-07-T-S

1 JP6 CON HDR-2.54 Male 1x2 Gold 5.84MH 
TH VERT

FCI 77311-118-02LF

6 JS1 – JS6 SHUNT JUMPER Sullins 
Connector Solutions

SPC02SYAN

1 L1 INDUCTOR 3.3uH 1.95A 30% SMD 
L4.8W4.8H2

Wurth Elektronik 744042003

1 PCB Printed Circuit Board - MCP8026 TQFP 
BLDC Motor Driver Evaluation Board

Microchip 
Technology Inc.

04-10322

7 Q1, Q2, Q3, 
Q4, Q5, Q6, 
Q7

TRANS FET N-CH FDD10AN06A0 60V 
50A DPAK-3

Fairchild 
Semiconductor®

FDD10AN06A0

1 R1 RES TKF 1R 1% 1/10W SMD 0603 Panasonic® - ECG ERJ-3RQF1R0V

1 R2 RES TKF 18k 1% 1/10W SMD 0603 ROHM 
Semiconductor

MCR03EZPFX1802

1 R3 RES TKF 11k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF1102V

1 R4 RES TKF 4.99R 1% 1/8W SMD 0805 Yageo Corporation RC0805FR-074R99L

3 R5, R8, R10 RES TKF 4.02R 1% 1/10W SMD 0603 Yageo Corporation RC0603FR-074R02L

3 R6, R88, 
R95

RES TKF 2k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF2001V

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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17 R7, R28, 
R30, R37, 
R47, R48, 
R51, R60, 
R63, R66, 
R69, R70, 
R71, R75, 
R76, R77, 
R78

RES TKF 47k 1% 1/10W SMD 0603 Stackpole 
Electronics Inc.

RMCF 1/16 47K 1% R

4 R9, R23, 
R24, R25

RES TKF 22k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF2202V

1 R11 RES TKF 10k 1% 1/10W SMD 0603 NIC 
Components Corp.

NRC06F1002TRF

6 R12, R15, 
R18, R22, 
R31, R42

RES TKF 47R 1% 1/8W SMD 0805 Yageo Corporation RC0805FR-0747RL

6 R13, R16, 
R19, R27, 
R35, R46

RES TKF 0.1R 1% 1/8W SMD 0805 Panasonic - ECG ERJ-L06KF10CV

3 R14, R17, 
R20

RES TKF 470k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF4703V

3 R21, R33, 
R41

RES TKF 2.49k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF2491V

3 R26, R34, 
R45

RES TKF 120k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF1203V

3 R29, R32, 
R36

RES TKF 300R 1% 1/10W SMD 0603 Yageo Corporation RC0603FR-07300RL

3 R38, R39, 
R40

RES TKF 2.4K 1% 1/10W SMD 0603 Yageo Corporation RC0603FR-072K4L

14 R43, R50, 
R54, R55, 
R65, R68, 
R82, R83, 
R84, R85, 
R86, R87, 
R89, R91

RES TKF 1k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF1001V

7 R44, R49, 
R53, R56, 
R64, R67, 
R90

RES TKF 3.74K 1% 1/10W SMD 0603 Yageo Corporation RC0603FR-073K74L

3 R52, R61, 
R62

RES SHUNT 0.01R 1% 5W SMD 
L11.35W6.35H4.57

TT Electronics Plc. OARSXPR010FLF

3 R57, R58, 
R59

RES TKF 4.7k 1% 1/10W SMD 0603 ROHM 
Semiconductor

MCR03EZPFX4701

3 R72, R73, 
R74

RES TKF 90.9k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF9092V

2 R79, R93 RES TKF 24.9K 1% 1/10W SMD 0603 Yageo Corporation RC0603FR-0724K9L

2 R80, R97 RES TKF 100R 1% 1/10W SMD 0603 ROHM 
Semiconductor

MCR03EZPFX1000

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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1 R81 RES TKF 30k 1% 1/10W SMD 0603 Stackpole 
Electronics, Inc.

RMCF0603FT30K0

1 R92 RES VARIABLE CC 10K 20% 150mW 
TH 296U

CTS® Corporation 296UD103B1N

1 R94 RES TKF 10.7k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF1072V

1 R96 RES TKF 7.5k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF7501V

4 SW1, SW2, 
SW3, SW4

SWITCH TACT SPST 12V 50mA 
TL3301NF160QG/TR SMD

E-Switch®, Inc. TL3301NF260QG/TR

10 TP1, TP2, 
TP3, TP4, 
TP5, TP6, 
TP7, TP8, 
TP9, TP10

CON TP LOOP SILVER 3.4x5 SMD Components 
Corp.

TP-107-2

1 U2 MCHP MCU 16-Bit 70MIPS 256kb 32kb 
DSPIC33EP256MC504-I/PT TQFP-44

Microchip 
Technology Inc.

DSPIC33EP256MC504-I/PT

1 U3 MCHP ANALOG MOTOR DRIVER 
MCP8026-115E/PT TQFP-48

Microchip 
Technology Inc.

MCP8026-115E/PT

1 U4 MCHP ANALOG OPAMP 4-Ch 10MHz 
MCP6024-E/ST TSSOP-14

Microchip 
Technology Inc.

MCP6024-E/ST

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
DS50002648A-page 40  2017 Microchip Technology Inc.

m Arrow.com.

http://www.arrow.com


MCP8026 TQFP BLDC MOTOR
DRIVER EVALUATION BOARD

Downloaded from Arr
USER’S GUIDE

Appendix C. Software
C.1 SOFTWARE LOCATION

The application software may be downloaded from the MCP8025/4 web page located 
on the Microchip web site, http://www.microchip.com.

C.2 SELECTED SOFTWARE CONSTANTS AND DEFINITIONS

1. FOSC
Microprocessor Oscillator Frequency in Hz. based upon PLL scaling.

2. FPWM = 15000, 20000, 40000, 50000
Selects dsPIC DSC PWM frequency in Hz.

3. PWMRESBITS = 7 or 8 or 9
Sets the PWM resolution and corresponding PLL divisor. 20 kHz may use 7, 8, 
or 9 bits. 40 kHz may use 7 or 8 bits. 50 kHz may use 7 or 8 bits.

4. FPLLO
PWM Phase Locked Loop Oscillator frequency.

5. LOOPMODE = CLOSEDLOOPMODE
Sets motor controller to use closed-loop control. The PID control functions will be 
used to control motor speed. 

6. LOOPMODE = OPENLOOPMODE
Sets motor controller to use open-loop control. The speed adjust input relative 
position will be used to set the motor speed. 

7. PWM_COUNTS_PER_PERIOD = (FPLLO/FPWM –1)
Defines the number of timer counts per PWM period.

8. RAMPUP_START_RATE_FULL_VOLTAGE
Defines the initial number of PWM periods to use to ramp the motor speed during 
startup. The firmware will force the number of PWM periods to occur between 
commutations. Both the RAMPUP_START_RATE_FULL_VOLTAGE and 
RAMPUP_END_RATE_OFFSET may need to be adjusted for different motors 
and voltages. The settings should be different by at least a value of 10. The motor 
will start with “RAMPUP_START_RATE_FULL_VOLTAGE” number of PWM 
periods occurring before the first commutation, then decrement the 
RAMPUP_START_RATE_FULL_VOLTAGE value and wait for the new number 
of PWM periods to occur before commutating again. This effectively reduces the 
time between forced commutations and allows for a controlled ramp up of motor 
speed during open loop starting.

9. RAMPUP_END_RATE_OFFSET
Defines the final number of PWM periods to use to ramp the motor speed during 
startup.

10. OPEN_LOOP_ACCEL_RATE
Defines the acceleration rate when changing speeds in open-loop mode.

11. OPEN_LOOP_DECEL_RATE
Defines the deceleration rate when changing speeds in open-loop mode.

12. MAX_DUTY_CYCLE
Defines the maximum desired PWM duty cycle.
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13. MIN_DUTY_CYCLE
Defines the minimum desired PWM duty cycle.

14. STARTUP_DUTY_CYCLE
Defines the initial PWM duty cycle during motor startup. Set this parameter to the 
duty cycle required to start the motor for a given supply voltage.

15. PHASE_ADVANCE_DEGREES
Defines the number of electrical degrees (in timer tics) that will be subtracted 
from the calculated commutation timer reload count. This allows for 
compensating for any latencies in the system.

16. ZC_BLANKING_COUNT
Defines the number of PWM periods that the ADC readings are ignored. This 
allows filtering of signals after commutation when high voltage and current spikes 
may be present. Set this value to 2 when using the Hurst DMB0224C10002 
motor that is available at Microchip Direct. Set the value to 1 for higher speed 
hobby motors like the Electrifly Rimfire 0.55 motor.

17. int ReferenceSpeed
Contains the motor target speed based upon the SPEED potentiometer input.

18. unsigned int DesiredPWMDutyCycle
Contains the desired PWM duty cycle based upon the SPEED potentiometer 
input.

19. volatile int CurrentPWMDutyCycle
Contains the current PWM duty cycle.

20. PWM_STATEn[] (n=PHASE=1,2,3)
Array containing the high-side and low-side gate driver output states for a given 
step of the six-step commutation algorithm.

21. IOCONn_LOCKSTATE (n = 1,2,3)
High-side and low-side gate driver output states for locking the rotor to a known 
position prior to motor startup.

22. BOOTSTRAP_CHARGE_STATE
High-side and low-side gate driver output states for charging the bootstrap 
capacitors prior to motor startup

23. MOTOR_SHUTDOWN_STATE
High-side and low-side gate driver output states that may be used when shutting 
down the motor.

24. ADC_MASK[]
A/D Back EMF mask used for majority detection.

25. ADC_XOR[]
A/D Back EMF mask used for majority detection.

26. ADC_BEMF_FILTER[]
A/D Back EMF filter table used to determine next commutation time.

27. BEMFCommState[7]
Table of expected commutation comparator values for a given state. Value is 
ADC comparator to look for when in a given PWM_STATE[x].
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C.3 DSPIC33EP256MC504 PIM PORT USAGE

C.3.1 Port A Mapping

C.3.2 Port B Mapping

#define AN0_MONITOR1  PORTAbits.RA0   /* AN0 - MONITOR1 */

#define AN1_MONITOR2  PORTAbits.RA1   /* AN1 - MONITOR2 */

#define UNUSED_RA2    PORTAbits.RA2   /* unused port bit */

#define UNUSED_RA3    PORTAbits.RA3   /* unused port bit */

#define FAULT_LED     PORTAbits.RA4   /* Fault LED */

#define TEST_LED      PORTAbits.RA4   /* Test LED */

#define NA_RA5        PORTAbits.RA5   /* N/A */

#define NA_RA6        PORTAbits.RA6   /* N/A */

#define DRIVER_CE     PORTAbits.RA7   /* driver CE pin */

#define SW1          !PORTAbits.RA8   /* SW1 Push Button */

#define UNUSED_RA9    PORTAbits.RA9   /* unused port bit */

#define UNUSED_RA10   PORTAbits.RA10  /* unused port bit */

#define AN2_MONITOR3  PORTBbits.RB0   /* AN2 - MONITOR3 */

#define AN3_IOUTB     PORTBbits.RB1   /* AN3 - IOUTB */

#define AN4_IOUTA     PORTBbits.RB2   /* AN4 - IOUTA */

#define AN5_MONITOR4  PORTBbits.RB3   /* AN5 - MONITOR4 */

#define SW2          !PORTBbits.RB4   /* SW2 Push Button */

#define PGD           PORTBbits.RB5   /* Programming Data */

#define PGC           PORTBbits.RB6   /* Programming Clock */

#define DE2_RX          PORTBbits.RB7   /* RX from DE2 Communications using RP39 
and UART */

#define nFAULT        PORTBbits.RB8    /* driver ILIMIT_OUT 1= ok, 0=Current 
Limit or fault, open-drain */

#define DE2_TX        PORTBbits.RB9   /* TX to DE2 Communications using RP41 
and UART */

#define PWM3H         PORTBbits.RB10  /* PWM3H */

#define PWM3L         PORTBbits.RB11  /* PWM3L */

#define PWM2H         PORTBbits.RB12  /* PWM2H */

#define PWM2L         PORTBbits.RB13  /* PWM2L */

#define PWM1H         PORTBbits.RB14  /* PWM1H */

#define PWM1L         PORTBbits.RB15  /* PWM1L */
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C.3.3 Port C Mapping

C.3.4 A/D Mappings

AN0 (RA0) = MONITOR1

AN1 (RA1) = MONITOR2

AN2 (RB0) = MONITOR3

AN3 (RB1) = IOUTB

AN4 (RB2) = IOUTA

AN5 (RB3) = MONITOR4

AN6 (RC0) = IOUTC

AN7 (RC1) = VDD_DIV16

AN8 (RC2) = Speed Pot

C.3.5 UART Mappings

RP39 = RX from DE2 Communications

RP41 = TX to DE2 Communications

C.4 COMMUNICATIONS MESSAGE MAPPINGS

           

#define AN6_IOUTC     PORTCbits.RC0   /* AN6 - IOUTC */

#define AN7_VDD_DIV16 PORTCbits.RC1   /* AN7 - VDD_DIV16 */

#define AN8_SPEED_POT PORTCbits.RC2   /* AN8 - Speed Pot */

#define UNUSED_RC3    PORTCbits.RC3   /* unused port bit */

#define UNUSED_RC4    PORTCbits.RC4   /* unused port bit */

#define UNUSED_RC5    PORTCbits.RC5   /* unused port bit */

#define UNUSED_RC6    PORTCbits.RC6   /* unused port bit */

#define UNUSED_RC7    PORTCbits.RC7   /* unused port bit */

#define UNUSED_RC8    PORTCbits.RC8   /* unused port bit */

#define UNUSED_RC9    PORTCbits.RC9   /* unused port bit */

Message Address

SET_CFG0_MSG 0x81

GET_CFG0_MSG 0x82

SET_CFG1_MSG 0x83

GET_CFG1_MSG 0x84

STAT0_MSG 0x85

STAT1_MSG 0x86

SET_CFG2_MSG 0x87

GET_CFG2_MSG 0x88
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C.5 MPLAB X COMPILER STARTUP

1. Start up the MPLAB X compiler (not supplied, available on the Microchip web 
site).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing project file named ADM00599_6STEP.
5. In the Projects window, right mouse-click on ADM00599_6STEP and select 

Properties. The page contains the project properties. Processor, Compiler, 
Hardware and Config settings may be changed here.

6. Right mouse-click on ADM00599_6STEP again and select “Make and Program 
Device”. This will compile the firmware and download it to the programming 
hardware.

7. The compiler results will be displayed in the Output window frame. Verify 
success.

C.6 MPLAB X IDE AND PICKIT 3 EXERCISE

1. Start up the MPLAB X (not supplied, available on the Microchip web site).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing workspace directory named ADM00599_6STEP or create a 
new one.

5. Connect the PICkit 3 programmer to header J1 on the evaluation board. Align Pin 
1 of the header with the Pin 1 mark on the programmer.

6. Set the bench power supply voltage control to minimum voltage output.

7. Turn on the power supply and set the output voltage to 14V. Turn off the power 
supply.

8. Connect the bench power supply to the evaluation board. Connect +V(14V) to 
J3-2 and –V (Ground) to J3-1.

9. Turn on the power supply.

10. Right mouse-click on ADM00599_6STEP in the Projects window and select 
“Make and Program Device”. This will compile the firmware and program the 
dsPIC33EP256MC504 processor.

11. The compiler results will be displayed in the Output window frame. Verify 
success.

12. Connect a Brushless DC (BLDC) motor to connector J4 (MOTOR). Connect the 
motor phase wires to the PH_A (J4-3), PH_B (J4-2), and PH_C (J4-1) terminals.

13. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

14. Turn the SPEED adjustment fully counter-clockwise. This sets the motor to the 
slowest speed.

15. Momentarily press the SW2 (RUN/STOP) switch to start the motor.

16. Momentarily press the SW2 (RUN/STOP) switch again to stop the motor.

17. Momentarily press the SW2 (RUN/STOP) switch again to start the motor.

18. Turn the SPEED adjustment clockwise. The motor speed should increase.

Note: The user may need to modify the paths to the source files and linker files 
based upon their locations on the host computer. Be sure to verify the 
Libraries contain the correct path to libdsp-elf.a
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19. You may probe the different test points on the board to see the various signals 
being generated. The Q1G through Q6G test points will show the external MOS-
FET gate drive signals. The D15 through D20 LEDs show the state of the PWM 
inputs to the MCP8026. The MON1 through MON3 test points show the output 
of the jumper-selected signals. PHA_FIL, PHB_FIL, and PHC_FIL are the filtered 
Back EMF voltages from the motor. They are used to determine the commutation 
time in the demonstration firmware. The SPARE_LED turns ON when a fault has 
occurred.

20. Stop the motor by pressing SW2 again.

21. Change the motor control from Closed Loop to Open Loop. This is done by 
editing the MCP802X_EVALUATION.C file.

22. Click on Source Files in the Projects window and then double-click on the 
MCP802X_EVALUATION.C entry.

23. Search for the preprocessor definition #define LOOPMODE.

24. Change the LOOPMODE definition from CLOSEDLOOPMODE to 
OPENLOOPMODE.

25. Right mouse-click ADM00599_6STEP in the Projects window and select “Make 
and Program Device”. This will compile the firmware and program the 
dsPIC33EP256MC504 PIM module.

26. The compiler results will be displayed in the Output window frame. Verify 
success.

27. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

28. Turn the SPEED adjustment fully counter-clockwise. This sets the motor to the 
slowest speed.

29. Momentarily press the SW2 switch again to start the motor.

30. Turn the SPEED adjustment clockwise. The motor speed should increase.

31. In OPENLOOPMODE, the motor speed is forced based upon the position of the 
SPEED adjust potentiometer. If the SPEED adjust is set to 60%, the firmware will 
set the PWM duty cycle to 60%. While this allows for simple control of the motor, 
it is not efficient. If the motor is externally loaded, the motor may not be able to 
maintain the manually set commutation time which will result in a motor stall. The 
motor runs more efficiently when the motor is allowed to commutate based upon 
rotor location and not by an external reference. In CLOSEDLOOPMODE, the 
motor will commutate at the proper time based upon the Back EMF information. 
If the motor is externally loaded, the motor will automatically adjust for the load 
in order to maintain the correct commutation time.

32. Momentarily press the SW2 switch again to stop the motor.
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